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We are glad to see some of our snowbirds returning. We welcome back you 

early birds and look forward to the rest of our members returning soon.  

With the schools starting early, the snowbirds returning, and the release of 

Windows 10, our members help program is getting a bit overloaded.  

We have over 500 members and only a few of us to do the repairs.  We can 

only handle so much within the hours that we are here,  so at this time, we 

will no longer be able to check out your system as a walk in or give you help 

while you wait.  

 If you need help installing Windows 10, or need tutoring of any kind, or 

special help with any problems, we will be glad to assist you but it must be 

by appointment only.   

All systems must be left if repairs are needed.  We try to get them fixed in 

the order they were brought in and we will get to them as soon as we can.   

 To schedule an appointment call the office at 624-4175 ext. 244 or 585-

0356.  

We regret that this is necessary. We hope you understand and will bear 

with us.   

Thank You. 

Ron  

Have a safe and happy Labor Day weekend. 

 

Charlotte County 

Computer Group 

2280 Aaron Street 

Port Charlotte, FL 

33952 

Phone: 941-585-0356 

941-625-4175  x244  

E-mail: office@cccgc.net 

 

http://www.cccgc.net
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Marion Newell won the 50/50. 

Congraulations! 

 Door Prize Winners 

Left To Right 

Ron Wallis 

Harold Howard  

Bill Tursellino 

Glenn Taylor 

George Kop 

 

Dick Braun was the lucky one to win the 

computer.  Better luck next time to every 

one else.  Thanks for participating. 

 

 

Sorry No Picture 
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  Program High-Lights 

The Executive Board and Members of CCCGC 

welcome each of you to the group.  We’re 

Here To Help. Membership Has Its Privileges. 

If you have any questions, concerns or need 

computer help, please contact us at the of-

fice. We will endeavor to help you any way 

we can. 

WELCOME New Members 

Leigh Murray  Buddy Bagwell  Willyse Bagwell 

Barney Baker  Michael Boyer  Nancy Corbin 

Antonio Cordo  Peter Hansen  Cecile Keller 

William Keller  Jose Pino  Lillian Racine 

Pamela Stern  Dave Stone           Norma VanDeventer 

Cindi Allen  Fernando Alvarado Judith Hodge 

Jack Moll  Noreen Belotte  Diana Lynn Dodge 

Joan Rosenthall  Anna Lenkersdorf David Sun 

Pilar Sun   

 

August 4th meeting was a busy night for Ron Wall and 

Yvette Pilch. 

Ron and I spent most of the evening presenting Windows 

10 to our members.  Because of illness and vacations, we 

combined the 5 P. M.  Basic class and the 6:00 Advanced 

class.   

Windows 10 just rolled out on July 29th, so we didn’t 

have a lot of time ourselves to get very familiar with the 

operating system. 

We had fun trying out the new menu and tiles and check-

ing out system properties.   We opened up Cortana, 

(which is similar to Siri), to see what it had to offer. 

You will find articles on Windows 10 in this month’s 

Bytes. 

Also, there will be a few classes offered on Win 10 that 

are on our events calendar.  Check it out. 
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For the latest Classes & Events Calendar 

Please click on the link below 

http://cccgc.info/?page_id=35  

For more information go to 

www.cccgc.info 

View/download Bytes 

Please be sure to  

register online for 

classes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

September 1, Meeting 

Officers and Board of  

Directors for 2015 

President:   Ron Wallis 

Vice President:  Dick Evans 

Secretary:  Ron Muschong 

Treasurer:  Harold Nixon 

Director:   John Hegard 

Director:  Grover Mudd 

 Director:  Lydia Rist 

Director:  Frank Messina 

 Director:  Linda Corrick 

The Charlotte 

County Computer 

Group Corp. 

Is a non-profit 501(c)3 

organization as classi-

fied by the Internal Reve-

nue Service. 

Donations, gifts, be-

quests, legacies, devices 

and transfers are de-

ductible under federal 

PROMOTING COMPUTER LITERACY AND EDUCATION IN CHARLOTTE COUNTY 

We’re on the 

Web 

www.cccgc.net 

Articles in the Bytes are courtesy  

of the following Tech Sites 

Into Windows 

http://cccgc.info/?page_id=35
http://www.cccgc.info
http://howtogeeks.com/
http://www.makeuseof.com/
http://ghacks.net/
http://www.windowssecrets.com/
http://intowindows.com
http://www.davescomputertips.com/
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(941) 625-4175 x244  
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Computer Group Corporation 

2280 Aaron Street 

Port Charlotte, FL 33952 
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What’s The Difference Between Windows 10 And 

Windows 8.1 

Back in June, 2011, when Microsoft showed off the Start screen of its upcoming Windows 8 at a conference, no one at Microsoft 

probably thought the main attraction of the operating system will force users to stay away from the operating system. 

Soon after the release of Windows 8, tens of third-party programs were released to help users bring back Windows 7-style Start 

menu to Windows 8. There were also tools to completely disable the newly introduced Metro or modern interface. The absence 

of familiar Start menu was deal breaker for most users. 

A year later, Windows 8.1 Update was released with a number of new features and improvements but it failed to change the per-

ception. 

Now that Windows 10 is ready and is available as a free upgrade to existing PC users running Windows 7 and Windows 8.1, 

many of you might want to know how different Windows 10 is from its predecessor Windows 8. 

Difference between Windows 8.1 and Windows 10 

Although Windows 10 is the successor of Windows 8, it’s actually what Windows 8 should have been. Like the new Start menu, 

Windows 10 includes the best of Windows 7 and Windows 8. 

The new Start menu vs the old Start screen 

The all new Start menu in Windows 10 feels designed for a PC as well as touch devices unlike the full-screen Start of Windows 

8/8.1. Although the Start menu in Windows 10 looks very different from the one in Windows 7, it actually behaves the same way. 

On the left-side of the Start menu, most used and recently installed apps appear. Beneath them, Settings app, Power, and File Ex-

plorer icons appear. 

Tiles on the right-side of the Start menu can be moved around, resized, and removed. In fact, you can make the default size of the 

Start menu much smaller by removing all tiles from the right-side of the Start. 

Resizable apps vs full screen apps 

In Windows 8, as you know, modern apps or apps installed from the Store always open in full screen and can’t be resized like 

traditional desktop programs. In Windows 10, all apps, including apps installed from Windows Store, can be resized, and they 

behave just like desktop applications. 

Cortana (digital personal assistant) 

Cortana is one of the main attractions of Windows 10. With Cortana, you can search the web, take notes, send emails, set 

alarms, search for files, and more. Note that Cortana is currently available in select regions only. 

Microsoft Edge vs Internet Explorer 

The new web browser is the default web browser in Windows 10. The Edge browser has been developed from scratch and ship 

with some brilliant features, including the ability to take notes right on webpages. 

           Conclusion on page 18 
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Classic Shell 

(Works beautifully with Windows 10) 

Version 4.2.4 –general release  

Thank you for installing Classic Shell™. It adds some missing features to Windows 7 and Windows 8 - like a classic start menu, 
start button, a toolbar for Windows Explorer and others. 

The latest version can be found on the Classic Shell website: 

http://www.classicshell.net/ 

For answers to frequently asked questions look here: 

http://www.classicshell.net/faq/ 

Or use the discussion forums to get help: 

http://www.classicshell.net/forum/viewforum.php?f=6 

Report problems in the Classic Shell development forums: 

http://www.classicshell.net/forum/viewforum.php?f=11 

Classic Start Menu 

Classic Start Menu is a flexible start menu that can mimic the menu behavior of Windows 2000, XP and Windows 7. It has a 
variety of advanced features: 

 Choose between “Classic” and “Windows 7” styles 

 Drag and drop to let you organize your applications 

 Options to show Favorites, expand Control Panel, etc 

 Shows recently used documents. The number of documents to display is customizable 

 Translated in 35 languages, including Right-to-left support for Arabic and Hebrew 

 Does not disable the original start menu in Windows. You can access it by Shift+Click on the start button 

 Right-click on an item in the menu to delete, rename, sort, or perform other tasks 

 The search box helps you find your programs and files without getting in the way of your keyboard shortcuts 

 Supports jumplists for easy access to recent documents and common tasks 

 Available for 32 and 64-bit operating systems 

 Has support for skins, including additional 3rd party skins. Make your own! 

       Fully customizable in both looks and functionality 

       Support for Microsoft’s Active Accessibility 

       Converts the “All Programs” button in the Windows menu into a cascading menu 

       Implements a customizable start button 

       Can show, search and launch Windows Store apps (Windows 8) 

Char lot te  Bytes  
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    Classic Shell         Continued from page 7 

Classic Explorer 

Classic Explorer is a plugin for Windows Explorer that: 

 Adds a toolbar to Explorer for some common operations (Go to parent folder, Cut, Copy, Paste, Delete, Properties, 
Email). The toolbar is fully customizable 

 Replaces the copy UI in Windows 7 with the more user-friendly “classic” version similar to Windows XP 

 Handles Alt+Enter in the folder panel of Windows Explorer and shows the properties of the selected folder 

 Has options for customizing the folder panel to look more like the Windows XP version or to not fade the expand but-
tons 

 Can show the free disk space and the total size of the selected files in the status bar 

 Can disable the breadcrumbs in the address bar 

 Fixes a long list of features that are broken in Windows 7 – missing icon overlay for shared folders, the jumping folders in 
the navigation pane, missing sorting headers in list view, and more 

Classic IE 
 

Classic IE is a plugin for Internet Explorer 9 and later versions that: 

 

 Adds a caption to the title bar so you can see the full title of the page 

 Shows the security zone in the status bar 

 Shows the loading progress in the status bar 

 

Installation instructions 

 

The toolbar for Windows Explorer may not show up automatically after installation. You have to do a few things before you can 
use it. 

 

Windows 7: Press Alt+V to open the View menu. Open the “Toolbars” sub-menu and select “Classic Exlporer Bar”. Keep in 
mind that the menu will always be displayed as long as the toolbar is visible. 

 

Windows 8: Press Alt+V to open the View ribbon. Click on the down arrow in the “Options” section. Select “Classic Explorer 
Bar” 

 

 

 

 

           Conclusion on page 16 
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Why iPhones Are More Secure Than Android Phones   

Here’s a dirty secret: Most Android devices never receive security updates. 

Ninety-five percent of Android devices can now be compromised via an MMS 

message, and that’s just the most high-profile bug. Google has no way to apply 

security patches to these devices, and manufacturers and carriers just don’t 

care. 

The Android ecosystem is becoming a toxic hellscape of unpatched devices rid-

dled with security holes. For comparison, when Apple’s iOS has a security hole, 

Apple can just update all supported iPhones with a new version. Even Windows 

phones are better than Android here. 

Android Phones Aren’t Guaranteed to Get Security Updates 

RELATED ARTICLE 

Why Your Android Phone Isn’t Getting Operating System Updates and What You Can Do About It 

Several times a year, Google releases a new version of Android with new features and performance improvements. Unfortu-

nately, most Android... [Read Article]   http://www.howtogeek.com/129273/why-your-android-phone-isnt-getting-operating-

system-updates-and-what-you-can-do-about-it/ 

The recent Stagefright MMS bug gives us a good case study, demonstrating what happens 

when someone discovers a security hole in Android. Google creates patches and applies 

them to the main Android open source project code. Google then sends these patches out 

to hardware manufacturers — Samsung, HTC, Sony, LG, Motorola, Lenovo, and others. 

Google’s involvement ends here. They can’t force manufacturers to actually release these 

patches. This often seems to be where the process ends. 

If a manufacturer does want to apply these patches, they have to apply them to a device’s 

Android code and build a new version of Android for that device. This is a separate process for every single phone and tablet that 

manufacturer supports. Each manufacturer then has to contact the carrier it sold the phones through and provide every individual 

device-specific patch to each carrier around the world. The manufacturer’s involvement ends here. Even if they go crazy and 

patch every single device they’re still supporting — very unlikely — they can’t force carriers to actually apply these patches 

Carriers can then choose to send the new, patched build of Android to their devices, or not. If they do, there’s a good chance it’s 

after an extensive testing period where the security holes will continue to stick around. Even if a carrier does want to do this, 

there’s a good chance they’ll only want to test the update on a few flagship phones, and not older devices. 

there’s a good chance it’s after an extensive testing period where the security holes will continue to stick around. Even if a carrier 

does want to do this, there’s a good chance they’ll only want to test the update on a few flagship phones, and not older devices.  

In practice, most Android devices just don’t receive security updates and are left vulnerable. Google hasn’t chosen to enforce the 

delivery of security updates like they enforce other things in contracts with manufacturers. Manufacturers create many, many 

different devices and don’t want to do the work of updating them all. Carriers ship many, many different devices and don’t want 

to bother testing them. Rather than delivering updates and maintaining old phones, they’d rather push customers to purchase 

new devices. Those security holes were fixed in the latest builds of Android, so a new device will be secure — at least until more 

holes are found and not patched. 

Yes, that “check for updates” feature on your Android device just checks if there’s any manufacturer-and-carrier-approved up-

dates. It’s not a reliable way to ensure you have security updates. 

            Continued page 10 

             

http://www.howtogeek.com/129273/why-your-android-phone-isnt-getting-operating-system-updates-and-what-you-can-do-about-it/
http://www.howtogeek.com/129273/why-your-android-phone-isnt-getting-operating-system-updates-and-what-you-can-do-about-it/
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iPhones Are Guaran-

teed Timely Security 

Updates 

RELATED ARTICLE 

Warning: Your Android Phone’s Web Browser Probably Isn’t 

Getting Security Updates 

The web browser in Android 4.3 and earlier has many big security prob-

lems, and Google won’t be patching it anymore. If you... [Read Article]    

http://www.howtogeek.com/208853/warning-your-android-phone%E2%

80%99s-web-browser-probably-isn%E2%80%99t-getting-security-updates/   

The Android update model is horrifically broken. It’s not just about receiving the lat-

est and greatest features. Instead, there’s no way to guarantee you have the current 

security patches. There’s really even no way to tell exactly which security holes have 

been patched in your device, as you depend on the manufacturer adding the patch to 

their custom build of Android and rolling it out to your device. 

Google has tried to avoid this with Google Play Services, which automatically updates 

on all Android devices. But it can only do so much. All Android devices running Android 4.4.4 and older — that is, most Android 

devices — currently have a web browser full of security holes because Google can’t update it. And now, almost all Android de-

vices can now be compromised with an MMS. 

Really, this is terrible. Imagine if Windows laptops never received security updates from Microsoft. Instead, Microsoft would issue 

patches to Dell, Lenovo, HP, and other manufacturers. The manufacturer might choose to patch it or not, and if they did choose 

to patch it, that patch would have to be approved by the store you bought the laptop from before it reached you. Microsoft 

would be rightly raked over the coals for this. Instead, Microsoft releases a patch and it’s provided to users of all models of Win-

dows PCs via WIndows Update. Even Google’s own Chrome OS works this way without manufacturers getting in the way. 

Want an actual guarantee of security updates for your smartphone? You pretty much have to buy an iPhone, although even Mi-

crosoft’s Windows phones are ahead of Android here. When a security hole is discovered in an iPhone, Apple can release a 

patch to every iPhone user all at once — even carriers don’t get in the way. 

Permissions and Privacy Controls Are Better on iOS, Too 

RELATED ARTICLE 

iOS Has App Permissions, Too: And They’re Arguably Better Than Android’s 

Android has a permissions system for individual apps, but so do iPhones and iPads. Android gives you a single prompt... [Read 

Article]  http://www.howtogeek.com/177711/ios-has-app-permissions-too-and-theyre-arguably-better-than-androids/ 

App permissions are another case where iPhones trounce Android phones. Android started out strong, offering “app permis-

sions” — you can see what an app requires before you install it and choose not to install it. iPhones now have an improved per-

mission system where you can actually pick and choose which data an app gets access to. Need to use an app, but don’t want to 

give it access to your contacts or other sensitive data? You can do this on iOS. 

On Android, app permissions are more like demands — take it or leave it. Apps often ask for many more permissions than they 

really need to function, and you never really know whether that game you installed is uploading your contacts list to a remote 

server. Google is working on adding a permission control to future versions of Android, but that’s too little, too late. Such func-

tions are currently only available in third-party custom ROMs after Google removed Android’s hidden permission manager. 

          Conclusion on page 18 

http://www.howtogeek.com/208853/warning-your-android-phone%E2%80%99s-web-browser-probably-isn%E2%80%99t-getting-security-updates/
http://www.howtogeek.com/208853/warning-your-android-phone%E2%80%99s-web-browser-probably-isn%E2%80%99t-getting-security-updates/
http://www.howtogeek.com/177711/ios-has-app-permissions-too-and-theyre-arguably-better-than-androids/
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8 Ways to Customize the Windows 10 Start Menu   

Windows 10 finally gives us back the Start Menu, and it’s much more customizable 

than it ever has been before. Here is a quick rundown of all the different ways that 

you can customize it. 

We’re guessing that they will continue to add more things over time, but for now 

this is the list of customizations that we’re aware of. 

Note: some of these pictures were taken on a pre-release version of Windows 10 

and look a little different, but it all works the same way. 

Organize, Edit, Delete, or Add New Items to the All Apps View 

RELATED ARTICLE 

Stupid Geek Tricks: How to Open the Start Menu Folder in Windows 7 or 10 

Are you one of those people that obsessively edits your start menu to keep it clean, tidy, and organized? Back in Windows XP, 

all you had to do was right-click on the start button to get to the folder, but Windows 7 changed it. [Read Article]  http://

www.howtogeek.com/howto/6463/stupid-geek-tricks-how-to-open-the-start-menu-folder-in-windows-7/ 

You can easily get to the Start Menu’s folder 

structure on the hard drive and edit, rear-

range, or even add new items to the All Apps 

view in the Windows 10 start menu. This will 

also give you the benefit of being able to 

search for these new shortcuts that you cre-

ate. 

It’s worth noting that the Start Menu folder 

won’t actually show the “Metro” apps, and 

you’ll need to deal with those elsewhere. For the most 

part, you can uninstall a Metro app by right-clicking on it 

in the Start Menu, except for the built-in ones.   

Resize the Start Menu 

You can quickly resize the Start Menu by simply moving 

your mouse to the top edge of the Start Menu and resiz-

ing down     

It’ll make the Start Menu wider if you have live tiles 

pinned. 

 

 

Continued on page 12 

http://www.howtogeek.com/howto/6463/stupid-geek-tricks-how-to-open-the-start-menu-folder-in-windows-7/
http://www.howtogeek.com/howto/6463/stupid-geek-tricks-how-to-open-the-start-menu-folder-in-windows-7/
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Pin and Unpin Tiles 

You can easily pin and unpin tiles by right-clicking on each 

one and selecting Unpin from Start (you can also drag them 

around to rearrange them). 

And if a tile isn’t actually pinned to the Start Menu, you can 

use the All Apps view to find it, and then right-click and 

choose Pin to Start from there. You can also pin regular 

apps to the right-hand side if you want. 

 

You might notice that you can also pin things to the task-

bar from the same view or uninstall them quickly as well. 

Resize Live Tiles 

You can change the size of the tiles by right-clicking on 

them and choosing Resize and then picking a size. 

The “Large” size is a little on the ridiculous size, but at 

least you have a lot of choices. 

Unfortunately the tiling is a little weird, so if you have an 

odd number of small tiles you’ll end up with blank space. 

Turn Off Live Tile Updates 

If all those blinking tiles end up annoying you, just right-click on them 

and choose “Turn live tile off.” 

Compared to the example above, you can see that the News tile is back to being a regular tile button.  

Personally we’re not fans of most live tiles… they are just too busy. 

Change the Start Menu (and Taskbar) Color 

You can easily change the color of your Start Menu and Taskbar by right-clicking any empty space and choosing Personalize. 

 

           Continued on page 13 

 

See us on the Web 

www.cccgc.net 

http://www.cccgc.net


Page 13 

Sept 2015 

Char lot te  Bytes  

8 Ways to Customize the Windows 10 Start Menu           Continued from page 12 

 

The Color and Appearance dialog will show up, 

and you can change the color to any awful style 

that you want. This one isn’t so great! 

 

 

 

 

Pin Items from the Left Side of the Start Menu 

You can pin applications to the left side of the Start Menu as 

well, but that’s not quite as intuitive… you need to drag and 

drop the shortcut for the application to the Start Button and 

you’ll see the tooltip change to “Pin to Start menu,” which is 

your cue to drop it there. 

 

 

Once you’ve done so, 

it should immediately 

pin that application to 

the left side of the 

Start Menu. You can 

also drag and drop the 

items up or down if 

you want. 

 

 

It’s weird that you can pin things to the right or left but you can’t drag and drop from right to left, only from left to right. 

To remove anything that you put on the left side, just right-click and choose “Remove from this list.” 

 

            Continued on page 14 

 

See us on the Web 

www.cccgc.net 

http://www.cccgc.net


Page 14 

Sept 2015 

8 Ways to Customize the Windows 10 

Start Menu       

Adding Control Panel and Special Items to the 

Left Side of the Start Menu 

You can also add some special built-in shortcuts to the left side of the Start 

Menu, but you’ll need to find a settings screen. Right-click on any of the 

white space and choose Properties. 

Adding Control Panel and Special Items to the Left Side of the 

Start Menu 

You can also add some special built-in shortcuts to the left side of the Start 

Menu, but you’ll need to find a settings screen. Right-click on any of the 

white space and choose Properties. 

Switch to the Start Menu tab, and then click the Customize button. 

 

Inside of this dialog you can select what special items you would like to pin 

to the Start Menu. 

 

 

 

 

 

 

Conclusion on page 15 
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8 Ways to Customize the Windows 10 Start Menu      

Continued from page 14 

 The Control Panel is really interesting 

because you can also use the Jump Lists 

to pin frequent sections into a folder that 

expands out. For Internet Explorer, you 

could have a set of pinned websites in-

side of the folder. 

Remove All Live Tiles and Make It 

Look Like Windows 7 

One of the best ways to customize the 

new Start Menu is to just remove all of 

the silly live tiles and make it look more 

like Windows 7. All you need to do is 

unpin all the items on the right side, put 

the items on the left side that you want, 

and then resize it down until it looks 

good. 
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   Classic Shell                             Conclusion from page 8 

  

If these steps don’t work, it may be possible that the Explorer extensions have been disabled. Check the following, then try to 
show the toolbar again: 

1) Open Internet Explorer and go to Tools -> Manage add-ons. Locate the add-ons “Classic Explorer Bar” and 
“ExplorerBHO Class” and make sure they are enabled. 

2) Maybe the browser extensions are disabled on your system. This is usually the default for Windows Server. Open 
the "Internet Options", go to the "Advanced" tab, and check the option "Enable third-party browser extensions". 

 

On Windows 7 you have to turn on the status bar from the View menu if you want to see the file sizes. 

On Windows 8 the Classic Explorer status bar is different from the one in Explorer. You can show/hide the first one from the 
Classic Explorer settings dialog and show/hide the second one from Explorer’s folder options dialog. 

 

The caption in Internet Explorer may not show up automatically after installation. You may get a prompt to enable the ClassicIE-

BHO plugin. If you get the prompt, select “Enable”. If you don’t get a prompt, go to Tools -> Manage add-ons and make sure the 

add-on “ClassicIEBHO” is enabled. After that restart Internet Explorer. 

Uninstallation 
 

To uninstall Classic Shell follow these steps: 

1) Open Control Panel -> Programs and Features and double-click on Classic Shell. Then follow the instruc-
tions. You may have to restart Windows to complete the process. 

2) If you installed any additional skins for the start menu you will have to delete them manually 

            

 

See us on the Web 
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Check if System Restore is enabled on Windows 

10 By Martin Brinkmann    

If you have set up Windows 10 on a new machine or up-

graded to the new operating system from a previous one, 

you may be surprised that one of the system's core restora-

tion features, System Restore, may not be running. 

System Restore is a handy feature that creates snapshots of 

certain files and information before critical operations such 

as updates or software installations takes place. 

This enables users of the system to go back to a previous 

state if things went wrong along the way. 

With System Restore disabled on at least some machines, it 

falls to the user to make sure backups are created regularly 

so that the system can be restored if the need arises. 

If you run Windows 10, you should check the System Restore preference to find out whether it is enabled or not. 

Use the shortcut Windows-Pause to open the System control panel applet quickly. 

    Locate the "advanced system settings" link on the left and click on it. 

    Switch to the "system protection" tab on the next screen. 

    There you find listed all drives connected to the system and their protection state. A state of "on" means that System Restore 
is enabled for the drive. 

    If that is not the case, select the drive and click on the configure button afterwards. 

    Switch to "turn on system protection" and select the maximum storage space that you want system restore to use on the de-

vice. A value between 5 to 10 Gigabyte is usually a good option. 

    Click apply and then ok to complete the process.                Repeat the proc-

ess for other drives if necessary. 

The system protection tab provides you with options to create a restore point, 

and to restore a data point that was created earlier. 

This may be handy to know as you may sometimes need to restore points 

manually. 

System Restore is not a catch-all solution on the other hand. While it works 

well usually when it comes to updates or software installations, it may not work 

at all if other changes are made to the system, for instance by malicious soft-

ware or data corruption. 

System Restore does not replace proper data backup. Check out our free drive 

backup guide if you need help finding a solution. 

Now You: If you run Windows 10, was System Restore enabled or disabled? 
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iPhones Secure                              Conclusion from page 10 

iPhones actually give you control over what apps can do on your phone, exposing app permissions as helpful privacy controls 

anyone can understand. This helps keep your private data secure. On Android, it’s really just up to the app — you can only con-

trol whether you use that app or not. 

Apple’s locked-down app store has gone overboard in banning specific types of content, but only allowing apps from an approved 

source does provide some additional security against malware. Most malware on Android comes from outside Google Play, often 

when a user downloads a pirated app and installs it. This isn’t possible without jailbreaking an iPhone. The iOS app store approval 

process is also a bit more rigorous, involving a person who actually tests the app rather than an automated algorithm. 

Google needs to fix this situation. It’s unacceptable for most Android devices to never receive security updates and be left vul-

nerable to an uncountable number of security holes. Many devices even have locked bootloaders, which would prevent you from 

patching the bug yourself by installing a custom ROM. 

Yes, Android is an open platform with many manufacturers involved, but so is Windows. Google needs to get its platform in or-

der. We’ll continue to see ever-worsening security outbreaks in Android land until the entire Android ecosystem starts caring 

about security and becomes capable of patching security problems in a timely and consistent manner, like every other modern 

operating system. 

Image Credit: Indi Samarajiva on Flickr 

The Microsoft Edge browser beats other popular web browsers in 

JavaScript performance, meaning this browser is actually comparable to its 

competitors unlike the Internet Explorer. Bing is the default search in Edge 

browser, but one can easily set Google as the default search in Edge 

browser. 

Although it doesn’t support extensions right now, it will support extensions in coming months. 

Settings app vs PC Settings 

The PC Settings app in Windows 8 was not easy-to-navigate. Microsoft has renamed PC Settings as Settings in Windows 10, and 

overhauled the same to include more settings and options. 

The Settings app in Windows 10 acts as the classic Control Panel (Control Panel is still exist) and is definitely better than the PC 

Settings. 

No confusing Charms Bar 

The Charms Bar has been put to rest in Windows 10. In Windows 10, to access app settings, you need to click the small menu 

icon (located on the left of the title bar). 

Better security 

Last but not the least, according to Microsoft, Windows 10 is the most secure Windows ever. The newly introduced Windows 

Hello allows you log in using your face or finger print on devices that support Windows Hello. Like Windows 8/8.1, Windows 

Defender ships with Windows 10 to take care of virus, malware, and other threats. 

And finally, if you are still apprehensive about the upgrade, we recommend you read our 7 reasons to upgrade to Windows 10 

article. 


